PERFORMANCE AND DURABILITY COMPARISON:
DELL LATITUDE 14 5000 SERIES VS. HP ELITEBOOK 840 G1

When you’re looking to purchase new business-class notebooks for a wide range of employees, durability and superior performance should dictate your choice.

In the Principled Technologies labs, we put the performance and durability of two systems to the test: the Dell Latitude 14 5000 Series (E5440) and HP EliteBook 840 G1. We purchased systems that were configured as similarly as possible, with the exception of the drive type (the Dell system had a solid-state hybrid drive while the HP system used a traditional hard disk drive) and the battery. At Dell’s request, we configured each notebook with the default battery. We found that:

- the systems performed comparably on the tests that we ran
- the Dell Latitude 14 5000 Series was better able to withstand being dropped to the floor from a height of 29 inches, suffering no damage to the hard drive after three drops
- the HP EliteBook 840 G1 took severe damage to the hard drive after only one drop, showing 90.1 percent damaged blocks
- the Dell Latitude 14 5000 Series had longer battery life, outlasting the EliteBook 840 G1 by over half an hour

The solid performance of the Dell Latitude 14 5000 Series coupled with its increased durability means that it can handle the tasks you need it to while also standing up to potential damage.
DURABILITY TESTING

When workers are on the go, accidents sometimes happen. Not all notebooks do an equally good job of surviving a fall. To see how our two test systems compared, we attempted to drop each system three times from a height of 29 inches (73.7 cm), or about desk-high. After each drop, we used HD Tune Pro 5.00 and HDDScan 3.3, tests that assess hard drive damage, to measure how well the system had protected its data. Once a system failed to boot, we conducted no further testing on that system. See Appendix A for detailed hardware information.

The Dell Latitude 14 5000 Series proved the more durable of the systems, sustaining no damage to the hard drive after three drops. During the second drop, the Dell Latitude 14 5000 Series suffered minor cosmetic damage, with the DVD drive faceplate breaking on one side. The HP EliteBook 840 G1 suffered no cosmetic damage, but made an intermittent clicking noise after the first drop. After the first drop, 90.1% of the HP system's blocks were damaged and PassMark BurnIn Pro registered an error when we attempted to launch the graphics tests for the second drop. On the second drop, the HP EliteBook 840 G1 ran only the CPU and Disk BurnIn tests as the 2D and 3D tests would not function. After the third drop, the HD Tune Pro scan showed 98.6 percent damaged blocks on the EliteBook 840 G1, and after this scan the drive was no longer visible in the OS or BIOS. The drive was also not visible when attached to another computer for scanning via USB dongle. We could not perform the HDDScan test, as the drive was too damaged to scan.

Figure 1 summarizes the results of our hard drive scans.

<table>
<thead>
<tr>
<th>Drop testing – physical data protection</th>
<th>Dell Latitude 14 5000 Series</th>
<th>HP EliteBook 840 G1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Drop 1</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HD Tune Pro 5.00 damaged blocks percentage</td>
<td>0.0%</td>
<td>90.1%</td>
</tr>
<tr>
<td>HDDScan 3.3 bad blocks</td>
<td>0</td>
<td>40,140</td>
</tr>
<tr>
<td><strong>Drop 2</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HD Tune Pro 5.00 damaged blocks percentage</td>
<td>0.0%</td>
<td>90.6%</td>
</tr>
<tr>
<td>HDDScan 3.3 bad blocks</td>
<td>0</td>
<td>78,426</td>
</tr>
<tr>
<td><strong>Drop 3</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HD Tune Pro 5.00 damaged blocks percentage</td>
<td>0.0%</td>
<td>98.6%</td>
</tr>
<tr>
<td>HDDScan 3.3 bad blocks</td>
<td>0</td>
<td>N/A</td>
</tr>
</tbody>
</table>

*Figure 1: The results of our physical data protection drop test for the notebooks.*
BATTERY LIFE COMPARISON

No one likes to be tethered to an outlet to do his or her work, so a system with lengthy battery life is always a plus. As Figure 2 shows, the Dell Latitude 14 5000 Series had a significantly longer battery life than the HP EliteBook 840 G1, outlasting it by 38 minutes using the BAPCo® MobileMark® 2012 benchmark.

![Figure 2: The Dell Latitude 14 5000 Series lasted 38 minutes longer than the HP EliteBook 840 G1 on a single charge.](image)

The Latitude also delivered a 73.2 percent higher Performance Qualification score (see Figure 3). The Dell Latitude 14 5000 Series battery shipped with a 65 Wh battery, while the HP EliteBook 840 G1 shipped with a 50 Wh battery, which can account for the difference in battery life.

<table>
<thead>
<tr>
<th>BAPCo MobileMark 2012</th>
<th>Dell Latitude 14 5000 Series</th>
<th>HP EliteBook 840 G1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Qualification score</td>
<td>123</td>
<td>71</td>
</tr>
<tr>
<td>MobileMark 2012 - Battery Life score (minutes)</td>
<td>533</td>
<td>495</td>
</tr>
<tr>
<td>MobileMark 2012 - Battery Life score (hours: minutes)</td>
<td>8:53</td>
<td>8:15</td>
</tr>
</tbody>
</table>

![Figure 3: Median scores for the BAPCo MobileMark 2012 benchmark. Higher numbers are better.](image)

PERFORMANCE TESTING

Because performance is so important to today’s worker, we used a number of benchmarks to rate the performance of the notebooks, and found that the Dell Latitude 14 5000 Series was up to completing the tasks workers require. We ran each test three times and report the median of the three runs.

Futuremark® 3DMark® Advanced rates a system’s graphics performance by testing the video card. Both systems had integrated Intel HD Graphics 4400 graphics.
adapters. We found that two systems performed comparably in this test, with the Dell Latitude 14 5000 Series achieving a 2.7 percent higher score (see Figure 4).

<table>
<thead>
<tr>
<th>3DMark Advanced</th>
<th>Dell Latitude 14 5000 Series</th>
<th>HP EliteBook 840 G1</th>
</tr>
</thead>
<tbody>
<tr>
<td>3DMark Score - Median</td>
<td>3,955</td>
<td>3,852</td>
</tr>
<tr>
<td>Graphics Score</td>
<td>4,896</td>
<td>4,707</td>
</tr>
<tr>
<td>Physics Score</td>
<td>2,365</td>
<td>2,355</td>
</tr>
<tr>
<td>Graphics Test 1</td>
<td>21.00</td>
<td>20.33</td>
</tr>
<tr>
<td>Graphics Test 2</td>
<td>21.59</td>
<td>20.61</td>
</tr>
<tr>
<td>Physics Test</td>
<td>7.51</td>
<td>7.48</td>
</tr>
</tbody>
</table>

**Figure 4: Median scores for the 3DMark Advanced benchmark. Higher numbers are better.**

HDXPRT 2012 measures the performance of systems on common media usages. Figure 5 shows the median results of our HDXPRT 2012 tests. The Dell Latitude 14 5000 Series had a 1.3 percent higher Create HD Score than the HP EliteBook 840 G1.

<table>
<thead>
<tr>
<th>HDXPRT 2012</th>
<th>Dell Latitude 14 5000 Series</th>
<th>HP EliteBook 840 G1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create HD Score (higher is better)</td>
<td>154</td>
<td>152</td>
</tr>
<tr>
<td>Media Organizer - minutes (lower is better)</td>
<td>6.57</td>
<td>6.56</td>
</tr>
<tr>
<td>Media Creator - minutes (lower is better)</td>
<td>13.86</td>
<td>13.91</td>
</tr>
<tr>
<td>Photo Blogger - minutes (lower is better)</td>
<td>9.69</td>
<td>9.82</td>
</tr>
<tr>
<td>Video Producer - minutes (lower is better)</td>
<td>2.83</td>
<td>2.97</td>
</tr>
<tr>
<td>Music Maker - minutes (lower is better)</td>
<td>3.39</td>
<td>3.44</td>
</tr>
</tbody>
</table>

**Figure 5: Median scores for the HDXPRT 2012 benchmark.**

BAPCo SYSmark® 2012 measures system performance for a number of common tasks including office productivity and media creation. Figure 6 shows the median results of our SYSmark 2012 tests. The Dell Latitude 14 5000 Series and HP EliteBook 840 G1 achieved identical SYSmark 2012 Overall Performance Ratings.

<table>
<thead>
<tr>
<th>BAPCo SYSmark 2012</th>
<th>Dell Latitude 14 5000 Series</th>
<th>HP EliteBook 840 G1</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYSmark 2012 Overall Performance Rating</td>
<td>114</td>
<td>114</td>
</tr>
<tr>
<td>SYSmark 2012 - Office Productivity</td>
<td>116</td>
<td>116</td>
</tr>
<tr>
<td>SYSmark 2012 - Media Creation</td>
<td>104</td>
<td>103</td>
</tr>
<tr>
<td>SYSmark 2012 - Web Development</td>
<td>104</td>
<td>106</td>
</tr>
<tr>
<td>SYSmark 2012 - Data/Financial Analysis</td>
<td>127</td>
<td>120</td>
</tr>
<tr>
<td>SYSmark 2012 - 3D Modeling</td>
<td>111</td>
<td>111</td>
</tr>
<tr>
<td>SYSmark 2012 - System Management</td>
<td>124</td>
<td>129</td>
</tr>
</tbody>
</table>

**Figure 6: Median scores for the BAPCo SYSmark 2012 benchmark. Higher numbers are better.**
WHAT WE TESTED

About BAPCo MobileMark 2012

BAPCo MobileMark 2012 is an industry-standard benchmark that provides a battery life rating and a performance rating based on common office scenarios. MobileMark 2012 uses applications and workloads specific to mobile systems. These include office activities like file and document management, data processing, and rich content creation. This module provides a score for battery life of the tested applications.

MobileMark 2012 measures system battery life in minutes. It records system battery life at the start of the benchmark and repeats the workload until the system battery life is depleted, or until the system powers down due to low battery life.

For more information on this benchmark, see www.bapco.com/products/mobilemark2012/index.php.

About Futuremark 3DMark Advanced

The Futuremark 3DMark Advanced benchmark suite tests system GPU DirectX® 11 performance and CPU workload processing performance, primarily to report a system’s 3D gaming capability. Tests include HDR rendering, shadow mapping, and pixel shading. For more information on this benchmark, see www.futuremark.com/benchmarks/3dmark/all.

About HDXPR 2012

The High Definition eXperience & Performance Ratings Test (HDXPR 2012) is a benchmark that evaluates the capabilities of PCs in consumer digital media uses, including the following:

- Media Organizer
- Media Creator
- Photo Blogger
- Video Producer
- Music Maker

For more information on HDXPR 2012, see www.hdxprt.com.

About BAPCo SYSmark 2012

BAPCo SYSmark 2012 is an application-based benchmark that tests performance in the following office workload scenarios: office productivity, media creation, Web development, data/financial analysis, 3D modeling, and system management. SYSmark 2012 records the time the system takes to complete each individual operation in each scenario. For more information on this benchmark, see www.bapco.com/products/sysmark-2012.
IN CONCLUSION

Durability and performance are important when selecting a notebook for employees in the workplace. The Dell Latitude 14 5000 Series performed comparably to or better than a similarly configured competitor system while also withstanding three drops without compromising physical data. The HP EliteBook 840 G1 incurred severe hard drive damage on the first drop and continued to take damage with every drop. This means that the Dell Latitude 14 5000 Series should handle common tasks for work and be durable enough for workers on the go.
## APPENDIX A – SYSTEM CONFIGURATION INFORMATION

Figure 7 provides detailed configuration information for the test systems.

<table>
<thead>
<tr>
<th>System</th>
<th>Dell Latitude 14 5000 Series (E5440)</th>
<th>HP EliteBook 840 G1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of processor packages</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Number of cores per processor</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Number of hardware threads per core</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Total number of processor threads in system</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>System power management policy</td>
<td>Dell</td>
<td>HP Optimized</td>
</tr>
<tr>
<td>Processor power-saving option</td>
<td>Enhanced Intel® SpeedStep® Technology</td>
<td>Enhanced Intel SpeedStep Technology</td>
</tr>
<tr>
<td>System dimensions (width × depth × height)</td>
<td>13.3” × 9.3” × 1.1”</td>
<td>13.3” × 9.3” × 0.8”</td>
</tr>
<tr>
<td>System weight</td>
<td>4.9 lbs.</td>
<td>4.0 lbs.</td>
</tr>
<tr>
<td><strong>CPU</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Intel</td>
<td>Intel</td>
</tr>
<tr>
<td>Name</td>
<td>Core™ i5</td>
<td>Core i5</td>
</tr>
<tr>
<td>Model number</td>
<td>4200U</td>
<td>4200U</td>
</tr>
<tr>
<td>Stepping</td>
<td>C0</td>
<td>C0</td>
</tr>
<tr>
<td>Socket type</td>
<td>Socket 1168 BGA</td>
<td>Socket 1168 BGA</td>
</tr>
<tr>
<td>Core frequency (GHz)</td>
<td>1.60</td>
<td>1.60</td>
</tr>
<tr>
<td>System Bus</td>
<td>Intel DMI 5 GT/s</td>
<td>Intel DMI 5 GT/s</td>
</tr>
<tr>
<td>L1 cache</td>
<td>32 KB + 32 KB (per core)</td>
<td>32 KB + 32 KB (per core)</td>
</tr>
<tr>
<td>L2 cache</td>
<td>256 KB (per core)</td>
<td>256 KB (per core)</td>
</tr>
<tr>
<td>L3 cache</td>
<td>3 MB</td>
<td>3 MB</td>
</tr>
<tr>
<td><strong>Platform</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Dell</td>
<td>Hewlett-Packard</td>
</tr>
<tr>
<td>Motherboard model number</td>
<td>0RT36Y</td>
<td>198F</td>
</tr>
<tr>
<td>Motherboard chipset</td>
<td>Intel 8 series chipset</td>
<td>Intel 8 series chipset</td>
</tr>
<tr>
<td>BIOS name and version</td>
<td>Dell A01 (09/18/2013)</td>
<td>Hewlett-Packard L71 Ver.01.04 (10/09/2013)</td>
</tr>
<tr>
<td><strong>Memory module(s)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Samsung® M471B5173BD0-YK0</td>
<td>Samsung M471B5173DB0-YK0</td>
</tr>
<tr>
<td>Type</td>
<td>PC3-12800</td>
<td>PC3-12800</td>
</tr>
<tr>
<td>Speed (MHz)</td>
<td>1,600</td>
<td>1,600</td>
</tr>
<tr>
<td>Speed running in the system (MHz)</td>
<td>1,600</td>
<td>1,600</td>
</tr>
<tr>
<td>Timing/Latency (tCL-tRCD-tRASmin)</td>
<td>11-11-11-28</td>
<td>11-11-11-28</td>
</tr>
<tr>
<td>Size (MB)</td>
<td>4,096</td>
<td>4,096</td>
</tr>
<tr>
<td>Number of memory module(s)</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Total amount of system RAM (GB)</td>
<td>4</td>
<td>4</td>
</tr>
</tbody>
</table>
# Performance and Durability Comparison: Dell Latitude 14 5000 Series vs. HP EliteBook 840 G1

<table>
<thead>
<tr>
<th>System</th>
<th>Dell Latitude 14 5000 Series (E5440)</th>
<th>HP EliteBook 840 G1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chip organization (single-sided/double-sided)</td>
<td>Double-sided</td>
<td>Double-sided</td>
</tr>
<tr>
<td>Channel (single/dual)</td>
<td>Single</td>
<td>Single</td>
</tr>
<tr>
<td><strong>Hard Disk</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Seagate® ST500LM000-1EJ16</td>
<td>Toshiba MK5061GSYN</td>
</tr>
<tr>
<td>Number of disks in system</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Size (GB)</td>
<td>500</td>
<td>500</td>
</tr>
<tr>
<td>Buffer size (MB)</td>
<td>64</td>
<td>16</td>
</tr>
<tr>
<td>RPM</td>
<td>5,400</td>
<td>7,200</td>
</tr>
<tr>
<td>Type</td>
<td>SSHD SATA 6Gb/s</td>
<td>SATA 3.0Gb/s</td>
</tr>
<tr>
<td>Controller</td>
<td>Intel 8 series chipset</td>
<td>Intel 8 series chipset</td>
</tr>
<tr>
<td>Driver</td>
<td>Intel 12.6.2.1000 (05/20/2013)</td>
<td>Intel 12.8.0.1016 (08/01/2013)</td>
</tr>
<tr>
<td><strong>Operating System</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Microsoft® Windows® 7 Professional</td>
<td>Microsoft Windows 7 Professional</td>
</tr>
<tr>
<td>Build number</td>
<td>7601</td>
<td>7601</td>
</tr>
<tr>
<td>Service Pack</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>File system</td>
<td>NTFS</td>
<td>NTFS</td>
</tr>
<tr>
<td>Kernel</td>
<td>ACPI x64-based PC</td>
<td>ACPI x64-based PC</td>
</tr>
<tr>
<td>Language</td>
<td>English</td>
<td>English</td>
</tr>
<tr>
<td>Microsoft DirectX version</td>
<td>DirectX 11</td>
<td>DirectX 11</td>
</tr>
<tr>
<td><strong>Graphics</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Intel HD Graphics 4400</td>
<td>Intel HD Graphics 4400</td>
</tr>
<tr>
<td>Type</td>
<td>Integrated</td>
<td>Integrated</td>
</tr>
<tr>
<td>Chipset</td>
<td>Intel HD Graphics 4400</td>
<td>Intel HD Graphics 4400</td>
</tr>
<tr>
<td>BIOS version</td>
<td>2171.13</td>
<td>2175.1</td>
</tr>
<tr>
<td>Total available graphics memory (MB)</td>
<td>1,696</td>
<td>1,740</td>
</tr>
<tr>
<td>Dedicated video memory (MB)</td>
<td>64</td>
<td>128</td>
</tr>
<tr>
<td>System video memory (MB)</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Shared system memory (MB)</td>
<td>1,632</td>
<td>1,612</td>
</tr>
<tr>
<td>Resolution</td>
<td>1,366 × 768</td>
<td>1,366 × 768</td>
</tr>
<tr>
<td><strong>Sound Card/Subsystem</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Realtek High Definition Audio</td>
<td>IDT High Definition Audio</td>
</tr>
<tr>
<td>Driver</td>
<td>Realtek 6.0.1.5978 (08/01/2013)</td>
<td>IDT 6.10.6486.0 (07/05/2013)</td>
</tr>
<tr>
<td><strong>Ethernet</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Intel Ethernet Connection I218-LM</td>
<td>Intel Ethernet Connection I218-LM</td>
</tr>
<tr>
<td>Driver</td>
<td>Intel 12.6.51.9427 (07/09/2013)</td>
<td>Intel 12.8.33.9427 (09/06/2013)</td>
</tr>
<tr>
<td><strong>Wireless</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Dell Wireless 1506</td>
<td>Intel Dual Band Wireless-N 7260</td>
</tr>
<tr>
<td>Driver</td>
<td>Atheros 10.0.0.227 (02/19/2013)</td>
<td>Intel 16.1.5.2 (08/29/2013)</td>
</tr>
<tr>
<td><strong>Optical Drive(s)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>HL-DT-ST GU90N</td>
<td>N/A</td>
</tr>
<tr>
<td>Type</td>
<td>DVD+-RW</td>
<td>N/A</td>
</tr>
<tr>
<td>System</td>
<td>Dell Latitude 14 5000 Series (E5440)</td>
<td>HP EliteBook 840 G1</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td><strong>Ports</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB</td>
<td>1 × USB 2.0, 2 × USB 3.0</td>
<td>3 × 3.0, 1 × 3.0 Charging</td>
</tr>
<tr>
<td>Other</td>
<td>SD™ Media card reader, Mini DP, VGA, HDMI</td>
<td>SD Media card reader, Display Port, VGA</td>
</tr>
<tr>
<td><strong>Monitor</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LCD type</td>
<td>WLED-backlit</td>
<td>LED-backlit HD SVA flat</td>
</tr>
<tr>
<td>Screen size</td>
<td>14.0”</td>
<td>14.0”</td>
</tr>
<tr>
<td>Refresh rate</td>
<td>60</td>
<td>60</td>
</tr>
<tr>
<td><strong>Battery</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Lithium-ion</td>
<td>Lithium-ion</td>
</tr>
<tr>
<td>Size (length × width × height)</td>
<td>8.12” × 2.75” × 0.75”</td>
<td>7.75” × 4.00” × 0.25”</td>
</tr>
<tr>
<td>Rated capacity</td>
<td>65 Wh</td>
<td>50 Wh</td>
</tr>
<tr>
<td>Weight</td>
<td>0.72 lbs.</td>
<td>0.57 lbs.</td>
</tr>
</tbody>
</table>

*Figure 7: Configuration information for the test systems.*
APPENDIX B – HOW WE TESTED

Measuring digital media capabilities with HDXPRT 2012

Setting up the test
1. Locate the optical drive or attach an external drive to the notebook.
2. Insert the HDXPRT DVD-ROM into the drive.
3. At the HDXPRT Install screen, click Install HDXPRT.
4. Accept the HDXPRT end user license agreement.
5. After the setup is complete, select Yes, I want to restart my computer now, and click Finish.

Running HDXPRT
1. Click the HDXPRT 2012 shortcut on the desktop.
2. Click Run HDXPRT.
3. Enter a test name, choose 4 iterations, and click Run.
4. The Results Screen automatically appears at the end of a successful run. The test results files are found in the `C:\ProgramFiles\HDXPRT\Reports\<TestName>` directory.
5. Run the test one more time, and record the results.

Measuring overall system performance with SYSmark 2012

Avoiding antivirus software conflicts

SYSmark 2012 is not compatible with any virus-scanning software, so we uninstalled any such software that was present on the notebook PCs before we installed the benchmark.

Avoiding pre-installed software conflicts

SYSmark 2012 installs the following applications, which its test scripts employ:

- ABBYY® FineReader Pro 10.0
- Adobe® Acrobat® Pro 9
- Adobe After Effects® CS5
- Adobe Dreamweaver® CS5
- Adobe Photoshop® CS5 Extended
- Adobe Premiere® Pro CS5
- Adobe Flash® Player 10.1
- Autodesk® 3DS Max® 2011
- Autodesk AutoCAD® 2011
- Google SketchUp® Pro 8
- Microsoft Internet Explorer®
- Microsoft Office 2010
- Mozilla® Firefox® Installer
- Mozilla Firefox 3.6.8
- Winzip® Pro 14.5

If any of these applications are already on the system under test, they will cause problems with the benchmark due to software conflicts. To avoid any such issues, before we installed the benchmark, we uninstalled all conflicting pre-installed software applications, including different versions of any of the programs SYSmark 2012 uses.
Setting up the test

Using the SYSmark built-in Configuration tool

This tool supports three levels of configuration:
1. Only makes changes that are REQUIRED in order for the benchmark to run.
2. Additionally, makes changes that are RECOMMENDED for repeatable results.
3. Additionally, makes OPTIONAL changes that help ensure best results.

The Configuration tool makes the following configuration changes at each of the three levels:

**Level 1 - Required**
- Disables User Account Control (UAC)
- Disables Windows Update
- Disables System Sleep and Hibernate
- Disables Low Battery Actions
- Disables Network Proxies

**Level 2 - Recommended**
- Creates BAPCo power scheme
- Sets Power Plan Type to High Performance
- Disables Windows Firewall
- Disables Windows Sidebar/Gadgets
- Disables Windows Pop-ups
- Disables Incoming Remote Desktop Connections
- Disables Windows Error Reporting
- Disables Screen Saver and Monitor Timeout
- Sets CPU Adaptive Mode
- Disables Desktop Slideshow
- Disables Disk Defrag

**Level 3 - Optional**
- Sets Hard Disk Timeout
- Disables Windows Defender
- Disables System Restore
- Ignores Laptop Lid Close
- Sets Maximum Display Brightness
- Disables Adaptive Brightness

**Installing SYSmark 2012 and configuring the system for testing**
1. Locate the optical drive or attach an external drive to the notebook.
2. Insert the SYSmark 2012 v1.5 Install DVD into the drive.
3. When the Autoplay menu appears, click Run SYSmark2012_setup.exe.
4. At the Welcome screen, click Next.
5. Enter the serial number, and click Next.
6. Accept the license agreement, and click Next.
7. At the Choose Components screen, select Full, and click Next.
8. At the Choose Install Location screen, accept the default location of C:\Program Files (x86)\BAPCo\SYSmark2012, and click Next.
9. At the Choose Start Menu Folder screen, click Install.
10. Insert Disc 2 when prompted.
11. At the InstallShield Wizard Complete screen, click Finish.
14. Click Configuration and choose all options.
15. Click Apply, and restart the computer when prompted.

Running the test
1. Launch SYSmark 2012 by double-clicking the desktop icon.
2. Enter a Project name and choose 3 iterations.
3. Click Run Benchmark.
4. Repeat steps 1 through 3 two more times, and record the last run.

Getting the SYSmark 2012 results
When SYSmark 2012 has completed, the Test Results Viewer appears. To submit these results to BAPCo, we saved the test results by performing the following steps:
1. Click Save.
2. Enter a name, and select FDR to save the results as an FDR file.
3. Click Save again, and select PDF to save the results as a PDF file.
4. Browse to the Documents directory where the result FDR and PDF files were saved.

Measuring battery life with MobileMark 2012

Avoiding antivirus software conflicts
MobileMark 2012 is not compatible with any virus-scanning software, so we uninstalled any such software present on the notebook PCs before we installed the benchmark.

Avoiding pre-installed software conflicts
MobileMark 2012 installs the following applications, which its test scripts employ:
- ABBYY FineReader Pro 11
- Adobe Acrobat Pro X
- Adobe Flash Player 11
- Adobe Photoshop CS5 Extended 12.04
- Adobe Photoshop Elements 10
- Adobe Premiere Pro CS 5.5
- CyberLink PowerDVD Ultra 11
- Microsoft Excel 2010 SP1
- Microsoft Internet Explorer
- Microsoft Outlook 2010 SP1
- Microsoft PowerPoint 2010 SP1
- Microsoft Windows Media Player
- Microsoft Word 2010 SP1
- Mozilla Firefox 10.0.2
- WinZip Pro 16

If any of these applications are already on the system under test, they could cause problems with the benchmark due to software conflicts. To avoid any such issues, before we installed the benchmark, we uninstalled all conflicting pre-installed software applications, including different versions of any of the programs MobileMark 2012 uses.

**Adjusting display brightness and power settings**

The brightness of a notebook’s display affects its battery life. Therefore, BAPCo requires that, before you test with MobileMark 2012, you do the following step: make sure the brightness of the notebook’s monitor is greater than or equal to 150 nits on a completely white screen while the notebook is unplugged and running on battery power. The measurement follows the standards from the Video Electronics Standards Association (www.vesa.org).

We complied with this standard for all the tests we ran by setting the notebook PC’s brightness as close to 150 nits as we could without going below that brightness level. We used the following procedure before we started each test. Note: This procedure assumes we began with the notebook plugged into the power supply.

1. To create a completely blank, white screen, open Microsoft Paint by clicking Start→All Programs→Accessories→Paint.
2. Press Ctrl+W to open the Resize and Skew dialog.
3. Under Horizontal and Vertical enter 200, and click OK.
4. Click the View tab.
5. Click Full screen to view a white screen.
6. Wait 45 minutes to allow the screen to warm.
7. Unplug the notebook from the power supply, and measure the display’s brightness using a luminance meter in the center of the screen. (We used the Gossen Mavolux5032C.)
8. If the reading is below or significantly greater than 150 nits, use the notebook’s keyboard screen-brightness-adjustment keys to bring the display as close to 150 nits as possible, then retest.
9. Allow the notebook to run on battery power for 10 minutes, re-measure the display, and adjust the brightness up or down as necessary.
10. Verify that the notebook saved the brightness setting by plugging in the system, unplugging it, and taking another reading.

   Note: If the notebook did not save the brightness setting, use its power management application(s) to set the brightness appropriately, and save that setting. If saving the setting is ineffective, use the keyboard brightness setting keys to adjust the screen to bring the display as close to 150 nits as possible. Next, note how many times you pressed the button to achieve the desired brightness. After unplugging the system under test, use the keyboard to set the desired brightness by pressing the brightness button as many times as you previously noted to return the screen to the correct brightness level.

**Using the MobileMark built-in Configuration tool**

This tool supports three levels of configuration:

1. Only makes changes that are REQUIRED in order for the benchmark to run.
2. Additionally, makes changes that are RECOMMENDED for repeatable results.
3. Additionally, makes OPTIONAL changes that help ensure best results.

   The Configuration tool makes the following configuration changes at each of the three levels:

   **Level 1 - Required**
   - Disables User Account Control (UAC)
   - Disables Windows Update
   - Disables System Sleep and Hibernate
   - Sets Screen Dimming Timeout (2 minutes)
   - Disables Low Battery Actions
   - Disables Network Proxies
   - Disables Autorun for Optical Drive

   **Level 2 - Recommended**
   - Creates BAPCo power scheme
   - Sets Power Plan Type to balanced
   - Disables Windows Firewall
   - Disables Windows Sidebar/Gadgets
   - Disables Windows Pop-ups
   - Disables Incoming Remote Desktop Connections
   - Disables Windows Error Reporting
   - Disables Screen Saver and Monitor Timeout
   - Sets CPU Adaptive Mode
   - Disables Desktop Slideshow
   - Disables Disk Defrag

   **Level 3 - Optional**
   - Sets Hard Disk Timeout
   - Disables Windows Defender
   - Disables System Restore
   - Ignores Laptop Lid Close
   - Sets Maximum Display Brightness
   - Disables Adaptive Brightness

   Because we are testing how well each system does out-of-box, we chose only the Required options in the Configuration tool.

   **Installing MobileMark 2012 and configuring the system for testing**
   1. Verify that the wireless adapter is enabled and connected to a wireless router that is not connected to the Internet.
   2. Locate the optical drive or attach an external drive to the notebook.
   3. Insert the MobileMark 2012 Install DVD into the drive.
   4. When the Autoplay menu appears, click Run MobileMark2012_Setup.exe.
   5. At the Welcome screen, click Next.
   6. Enter the serial number, and click Next.
   7. Accept the license agreement, and click Next.
   8. At the Choose Components screen, select Full, and click Next.
9. At the Choose Install Location screen, accept the default location of C:\Program Files (x86)\BAPCo\MobileMark2012, and click Next.
10. At the Choose Start Menu Folder screen, click Install.
11. Insert Disc 2 when prompted.
12. At the InstallShield Wizard Complete screen, click Finish.
14. Click Configuration and choose only the Required options.
15. Click Apply, and restart the computer when prompted.
16. Adjust the screen brightness to no less than 150 nits:
   a. Click the Windows Start button, and type power options in the Windows Start Search box.
   b. Click Change plan settings.
   c. Click Change advanced power settings.
   d. Expand the Display option, and change the Display brightness on battery and plugged in to the correct percentage that produces no less than 150 nits.
      Note: If you are unable to save these settings, please see the Displaying Brightness section above.

Conditioning the battery
1. Plug the AC power adapter into the notebook PC, and completely charge the battery.
2. Install MobileMark 2012, following the steps we outlined in the Installing MobileMark 2012 section.
3. Double-click the MobileMark 2012 icon on the desktop.
4. Click the Office Productivity icon.
5. Type System Conditioning as the name for this test in the Project Name, check the box next to conditioning, and click Continue.
6. If MobileMark 2012 lists no problems or warnings, click Continue. If it does list any problems or warnings, close MobileMark 2012, and correct the problem(s) before proceeding.
7. When prompted, unplug the AC power adapter. The Office Productivity test begins immediately.
8. The test is complete when the notebook PC has fully depleted its battery and is no longer operational when running on battery power.
9. Plug the AC power adapter into the notebook PC, and completely charge the battery.

Measuring battery life with MobileMark 2012
We performed the following steps to run the MobileMark 2012 Office Productivity benchmark:
1. Double-click the MobileMark 2012 icon on the desktop.
2. Select the Office Productivity test by clicking the Office Productivity icon.
3. Enter a name for this test in the Project Name field, and click Continue.
4. If MobileMark 2012 lists no problems or warnings, click Continue. If it does list any problems or warnings, close MobileMark 2012, and correct the problem(s) before proceeding.
5. When prompted, unplug the AC power adapter. The test begins immediately.
6. The Office Productivity test is complete when the notebook PC has fully depleted its battery and is no longer operational when running on battery power.
   We executed the MobileMark 2012 Office Productivity test three times on the system and took the median battery life run as the representative score for that test.
Getting the MobileMark 2012 results

After each MobileMark 2012 Office Productivity test completed, we plugged the AC power adapter into the notebook PC and turned on the system. MobileMark 2012 started automatically after the system booted, then analyzed the test scores and opened the Test Results Viewer with the results from the last test.

To submit these results to BAPCo, we saved the test results by performing the following steps:

1. Click Save.
2. Enter a name and select FDR to save the results as an FDR file.
3. Click Save again, and select PDF to save the results as a PDF file.
4. Browse to the Documents directory where the result FDR and PDF files were saved.

Measuring graphics performance with 3DMark Advanced

Installing 3DMark

2. Install 3DMark by double-clicking the 3DMark_v110_installer.exe file; leave the default options set.
3. At the Choose Setup Language screen, choose English, and click Next.
4. At the Welcome screen, click Next.
5. At the License Agreement screen, click I accept the terms of the license agreement, and click Next.
6. At the Setup Type screen, click Complete, and click Next.
7. At the Ready to Install the Program screen, click Install.
8. When the 3DMark Read Me page appears in your Web browser, review the document, and click Close when you are finished.
9. At the Setup Complete screen, click Finish to restart the computer.
10. Download and install the 3DMark patch 3DMark_v1-2-250.
11. Launch 3DMark Advanced by double-clicking on the 3DMark desktop icon. Enter the registration code, and click Register.
12. Exit 3DMark Advanced.

Running 3DMark Advanced

1. Boot the system and open an administrative command prompt:
   a. Click the Windows Start button.
   b. Type `cmd` and right-click `cmd.exe`.
   c. Select Run as administrator.
2. Type `cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks`
3. Do not interact with the system until the command completes.
4. After the command completes, wait 5 minutes before running the test.
5. Double-click the 3DMark desktop icon to launch the benchmark.
6. In the 3DMark Main section, click the Performance option under Preset, and select Benchmark tests only.
7. Click Run 3DMark.
8. When the benchmark run completes, take a screenshot of the results, and record them as follows:
   - 3DMark Score
   - Graphics Score
• Physics Score
• Graphics Test 1
• Graphics Test 2
• Physics Test
9. Shut down the system.
10. Repeat steps 1 through 9 four more times, and report the median of the last three runs.

Measuring durability
This test measures the damage that the impact from a drop of 29 inches inflicts upon an open notebook running PassMark® BurnIn Test v7.1 Professional.

Setting up PassMark BurnIn Test v7.1 Professional
2. Install BurnIn Test:
   a. Double-click the BurnIn Test bitpro_x64.exe file.
   b. In the Setup – BurnIn Test window, click Next.
   c. Accept the agreement, and click Next.
   d. Leave the default destination location, and click Next.
   e. Leave the default folder name, and click Next.
   f. Click Install.
   g. At the Completing the BurnIn Test Setup Wizard screen, click Finish.
   h. When the BurnIn Test by PassMark Software screen opens, enter the username and key, and click Continue.
3. Configure BurnIn Test:
   a. Click Configuration, and select Test Selection and Duty Cycles.
   b. In the Test selection and duty cycles screen, set the CPU, 2D Graphics, 3D Graphics and Disk(s) fields to 25%.
   c. Deselect all other tests that may be selected by default.
   d. Click OK.
   e. Click Configuration, and select Test Preferences.
   f. Click the Disk tab, and check the Automatically select all hard drives at the start of testing box.
   g. Click the Pre-Test tab, and select the None (start immediately) radio button.
   h. Click OK.

Running PassMark BurnIn Test v7.1 Professional
1. Launch PassMark BurnIn Test v7.1 Pro by double-clicking the BurnIn Test icon on the Desktop.
2. Start the test by clicking the green triangle.

Conducting the drop test
We used a Lansmont PDT56ED Precision Drop Tester, with a landing area covered by commercial carpet. We opened the notebook so that the screen and keyboard formed a 120-degree angle, and then placed the notebook flat on the platen. Orienting the notebook in this way resulted in a flat drop. (Figure 8 shows our test setup.)

To allow us to scan the notebooks identically, we booted to a Hiren’s BootCD and installed the hard disk scanning software to the Microsoft Windows 7 virtual machine’s RAM disk. Running the scanning software from RAM, we scanned the hard disk with HD Tune Pro 5.00 and HDDScan for Windows 3.3, and recorded the number of bad sectors and blocks before and after the drop test. We also recorded any other physical defects, such as cracks or breaks.
in the display, as well as separated hinges or displaced screws, which the impact of the drop caused. We took still photographs of the notebooks before and after each drop. We dropped each notebook once, using this process:

1. Install PassMark BurnIn Test v7.1 Pro onto the test notebook, as outlined above.

2. Run HD Tune Pro 5.00 and HDDScan 3.3 to get baseline data on the state of the hard disk. Boot the system using a Hiren’s BootCD.
   a. Install HD Tune Pro 5.00:
      i. Insert a USB flash drive containing the HD Tune Pro installation executable, and click once on My Computer.
      ii. Navigate to the USB drive, and double-click the hdtunepro_500_trial.exe installation file to install the application.
      iii. At the welcome screen, click Next.
      iv. Click the I accept the agreement radio button, and click Next.
      v. In the Select Destination Location window, click Browse.
      vi. Click the RAMDisk drive once to select it, and click OK.
      vii. Click Next in the next two windows.
      viii. Leave check box empty for Create a desktop icon, and click Next.
      ix. Click Install.
      x. Leave the check box checked for Launch HD Tune Pro, and click Finish.
   b. Run the HD Tune Pro 5.00 Error Scan:
      i. Select the Error Scan tab.
      ii. Click Start in the right hand pane.
      Note: The Error Scan is complete when the Start button changes from grey to black.
   c. Save the Error Scan Results.
   d. Click the Copy information to clipboard button on the upper right hand menu bar (it is the first button on the left):
      i. Open a new text file by clicking Start→Run, typing notepad, and clicking OK.
      ii. In the Notepad window, click Edit→Paste.
      iii. Click File→Save As, enter an appropriate filename using a .txt extension, and choose the location to save the file (we saved ours to a USB flash drive). Click Save.
   e. Close the HD Tune Pro 5.00 Hard Disk Utility.
   f. Scan the notebook’s hard drive with HDDScan for Windows version 3.3:
      i. Open the HDDScan folder, and double-click the HDDScan.exe executable file to run the application.
      ii. Click Tasks→Surface Tests to open the Test Selection window.
iii. Select Verify from the list of tests, and click Add Test.
iv. At the conclusion of the run, double-click the VR-Verify test id in the Test Manager window to open up the results.
v. Select the Report tab, and copy and paste the test results into Notepad.
vi. Save the results as a text file.

3. Set the height of the platen on the Lansmont Precision Drop Tester to 29 inches above the surface of the 28-ounce commercial carpeting.

4. Place the fully-charged notebook onto the platen of the drop tester, with the notebook’s base flat on the platen and the screen facing forward, open at a 120-degree angle.

5. Launch PassMark BurnIn Test.

6. Unplug the notebook, and drop the notebook onto the commercial carpeting.

7. Wait until the notebook is completely still.

8. If the battery or any other components come off the system, inspect them for damage, and reinstall them if possible.

9. Take digital pictures of the notebook from all angles after completing the checklist.

10. Stop PassMark BurnIn Test.

11. Reconnect the notebook’s AC adapter.

12. Run HD Tune Pro 5.00 and HDD Scan 3.3 using the process in Step 2, and record the results as the notebook’s post-test disk status.
ABOUT PRINCIPLED TECHNOLOGIES

We provide industry-leading technology assessment and fact-based marketing services. We bring to every assignment extensive experience with and expertise in all aspects of technology testing and analysis, from researching new technologies, to developing new methodologies, to testing with existing and new tools.

When the assessment is complete, we know how to present the results to a broad range of target audiences. We provide our clients with the materials they need, from market-focused data to use in their own collateral to custom sales aids, such as test reports, performance assessments, and white papers. Every document reflects the results of our trusted independent analysis.

We provide customized services that focus on our clients' individual requirements. Whether the technology involves hardware, software, Web sites, or services, we offer the experience, expertise, and tools to help our clients assess how it will fare against its competition, its performance, its market readiness, and its quality and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked together in technology assessment for over 20 years. As journalists, they published over a thousand articles on a wide array of technology subjects. They created and led the Ziff-Davis Benchmark Operation, which developed such industry-standard benchmarks as Ziff Davis Media’s Winstone and WebBench. They founded and led eTesting Labs, and after the acquisition of that company by Lionbridge Technologies were the head and CTO of VeriTest.

---

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

Disclaimer of Warranties; Limitation of Liability:
PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS TESTING, HOWEVER, PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL PERSONS OR ENTITIES RELYING ON THE RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC., ITS EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S TESTING. CUSTOMER’S SOLE AND EXCLUSIVE REMEDIES ARE AS SET FORTH HEREIN.